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ACCESSING CRASHMAP PRO 

To access CrashMap Pro, click on this link 

INTRODUCTION 

CrashMap Pro is a new solution created by the developers of the popular www.crashmap.co.uk website.  We 

have received requests from professional users such as transport planners, local authorities and police forces 

to create a better online tool which will allow more powerful searches and printing options. 

This User Guide has been created to guide you through the system currently in development and we welcome 

your feedback to information@crashmap.co.uk  

NAVIGATING THE MAP 

The CrashMap Pro Web Map consists of a full-page map with a series of buttons along the top banner and in 

the top right corner of the map, which we will look at in more detail in the following sections of the guide. 

  

Navigating this map is intuitive. To change the zoom of the map, click the  and  buttons in the top left 

corner. To change the extent (the portion of the map visible on the screen), either click and drag the map. The 

map can be made full screen using the  button, which can then be undone by pressing the  button. 

There is also a search bar in the top left corner of the map to search by address. 

 

Finally, in the bottom left corner the scale of the map is visible. 

 

  

https://agilysis.maps.arcgis.com/home/item.html?id=fdc32927b7234052847ba11206d21615
http://www.crashmap.co.uk/
mailto:information@crashmap.co.uk
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On the right of the banner at the top of the Web Map there are eight 

icons: 

Each of these will open a different window on the right of the screen. Clicking the  button in the banner at 

the top of each window will collapse the window to the banner, and the  button will expand it again. The  

button will close the window. Note that only one of these windows can be open at any time. 

Selecting the first ‘Legend’ icon  displays the legend of the map. The second ‘Filter’ icon  opens the filters 

window, which will be explained in the subsequent filters section. The third ‘Measurement’ icon  opens the 

measurement window, which will be explained in the measurements section. Selecting the fourth ‘Basemap 

Gallery’ icon  allows the user to change the underlying basemap. There is a selection of OS maps to choose 

from with various colour schemes and labelling. 

The fifth ‘Layer List’ icon  opens the Layer List window, which will be explained in the Layers section.  

The sixth ‘bookmarks’ icon  opens the Bookmarks window. This allows 

you to name and save the current map extent and return to it later. You 

can add  , edit bookmark name  and delete  existing 

bookmarks. (Please note: Bookmarks are saved in the web browser’s cache. 

They will be removed if you clear the browser cache).  

 

 

 The seventh ‘About’ icon  opens the About window that provides information about CrashMap, including 

data sources. 
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The final icon  gives the option to print the map. The layout and format of the print are selected using the 

dropdowns. The ‘Advanced’ button allows the user to manually set the scale, extent, scale bar units, height, 

width and quality of the print. Each print appears listed in the pop-up window. Clicking on these opens the 

print in a new browser tab. The list of prints can be cleared by clicking the ‘Clear prints’ button. 

 

 

 

 

 

 

 

 

 

 

FILTERS 

On the right of the banner at the top of the map is the ‘Filters’ icon 

which opens the Filter widget window. Each of these filters are 

turned on or off using the switches  to the right. The filters allow the user 

to filter crashes by year, severity, Highway Authority, the involvement of 

different road user types and the involvement of certain casualty types. 

When multiple filters are on, only crashes satisfying all conditions are 

shown. Each filter can be collapsed or expanded using the  and  

buttons on the edge of the left, and the entire pop-up window can be 

collapsed, expanded or closed using the ,  and  buttons. 

On opening CrashMap Pro the ‘Year’ filter is active and filters on crashes 

between 2017 and 2018. 

The ‘Severity’ and ‘Highway Authority’ filters are multi-select filters.  

Multi-select filter options vary depending on the number of unique records 

in the data. 

With the ‘Severity’ filter simply check 

or uncheck  any number of the 

boxes on the drop-down list and 

apply  the filter to limit the 

number of crashes displayed. 
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With the ‘Highway Authority’ filter, due to the number of choices there are more options available. 

The user can scroll through the list of Highway Authorities and check all that 
apply or use the search function to find a Highway Authority by name. 

 

There are three buttons at the 

bottom of the drop-down. The  

button shows the full list of Highway 

Authorities, whilst clicking the  

button will limit the list to those 

selected. To reset the selection, click 

on the button so that no 

authorities are selected. 

 

 

 

When a multi-select filter is off  the selected attributes are remembered, just not applied. 

At the bottom right of the Filters panel is the filter actions button . Click on this will open the filter options 

. 

There are 3 options: 

Reset Filters (except custom) . This will remove all user values in the pre-set filters and return the filtering 
to its initial state. 

Create a Custom Filter . This will open the Custom Filters panel (see below) 

Close Filter Options . 

 

CUSTOM FILTERS 

Clicking the ‘Create custom filter’ button  under the filter options menu  at the bottom right of the pane 

allows the user to create their own filter. 

Upon clicking this button, the user is prompted to select a layer to apply 

filters to.  

 

 

Upon selecting a layer, the user can add expressions and sets (a 

combination of expressions) to the filter.  
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Add Expression – 

An expression is a single logical statement about objects in your layer. The filter will only show objects for 

which this statement is true. 

For example, the user could filter for a specific date period 

by adding the following expression: 

Where the field is ‘Date and Time (Date)’ and the query 

can be between dates, after a certain date or on a specific 

date. 

 

Or the user could be interested in Collisions that involved multiple 

vehicles. Where you can select a specific value, values between, or 

values greater than or less than a value.  

 

 

Clicking the ‘Set input type’ button  in the bottom right corner 

allows the user to change whether the last part of the statement is a 

‘Value’ (a single fixed value, as above), a ‘Field’ (a field from the 

attribute table), ‘Unique’ (a specific value taken from the attribute 

table, for which the user will be offered a drop-down list to choose 

from) or ‘Multiple’ (a list of possible values). 

For example, if the user wanted to filter all collisions involving more 

than 5 vehicles, they would choose ‘value’. If the user wanted to 

filter where vehicles is a specific number (e.g. 24), setting the input 

category to ‘Unique’ would give them a drop-down list of specific 

values to choose from. 

The user can continue to add expressions to the custom 

filters and set the filter rule to be either requires all the 

expressions held within it to be true or requires any of 

the expressions to be true.  

Note: This is where custom filters are different to pre-set filtering using multiple filters. In custom filtering, the 

filtering rule can be set to either ‘All’ or ‘Any’. The pre-set filtering is always ‘All’. 

 

Add Set – 

A set is a combination of expressions. To create a ‘set’ click on the ‘+Add Set’ button at the 
bottom of the Custom Filters Pane 

A set will start with two expressions and more can be added by clicking on the symbol 
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Each ‘Set’ requires the filtering to be either all the 

expressions held within it to be true or requires any 

of the expressions to be true. 

This is were more complex scenarios can be developed as the expressions within a ‘set’ could be ‘Any’ while 

the combination of expressions could be set to ‘All’ 

For example, if a user were interested in collisions involving 3 or more 
vehicles on wet roads, that ‘either’ involved a pedestrian or a child, 
you would use a ‘Set’ to add two filters, one to select collisions 
involving a pedestrian casualty and one to select collisions involving a 
child casualty, and the expression rules to be ‘any of the following 
expressions in this set are true’. 

Then for the main custom filter – set the filter rule to be ‘display 
features in the layer that match all of the following expressions’. 

 

The ‘Set’ expressions would then filter for any collision where there 

was ‘either’ a pedestrian casualty or a child casualty rather than 

collisions involving ‘both’ a pedestrian and a child, and the main 

expression would filter only for collisions that involved ‘either’ a 

pedestrian or child casualty and more than 3 vehicles on wet roads. 

 

 

 

A filter can be removed from the list of expressions or from a set of expressions by clicking on the  icon 

The switch  in the top right of the ‘Custom filter’ pane determines whether the filter is on or off. To return 

to the main filters click the  button in the top right of the pane. Note that closing this pane does not 

automatically turn the custom filter off and custom filters will remain until the CrashMap Pro window is closed 

or the page refreshed. 
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LAYERS 

Selecting the ‘Layer List’ icon in the top right corner will open the list of available layers (‘CrashMap’ 

and ‘Labels’) and tables (‘Vehicles’ and ‘Casualties’). 

The ‘CrashMap’ layer shows crashes coloured by severity. It is 

overlaid on the basemap, and can be removed or added to the 

map by deselecting or selecting the tick box  to the left of 

‘CrashMap’. Clicking on ‘CrashMap’ will display/hide the legend 

for the layer. This legend is also visible in the ‘Legend’ window 

when the layer is made visible. 

Clicking the  button gives the user 

the option to turn all layers on/off or 

to expand/collapse the legends of all layers. 

Clicking the  icons to the right of each label give the user further options for the 

layer and tables.  

 

The ‘Zoom to’ option will change the zoom of the map to show the 

entire layer within the extent. The ‘Transparency’ option allows the 

user to adjust the transparency of the layer. 

 

The ‘Disable pop-up’ option, which is replaced with an ‘Enable pop-

up’ option when selected, toggles whether or not a pop-up 

showing data appears when selecting an object within the later. 

This will be covered more in the following Viewing Collision Data 

section.  

When you zoom in beyond a certain level crashes will be labelled 

with their Accident ID. 

In areas where crashes are close together individual labels will be 

displayed as you zoom in further. 

Labels can be toggled off/on with ‘Hide labels’ or ‘Show labels’ from 

the  menu. 

 

 

 

The ‘View in Attribute Table’ option adds the data from the layer to the set of attribute tables that appear at 

the bottom of the screen. These attribute tables will also be discussed further in the following section. Finally, 

the ‘Show item details’ option will open a new tab in the browser showing the layer or table, and information 

about the layer or table, in ArcGIS Online. 
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MEASUREMENTS 

Selecting the ‘Measurements’ icon in the top right corner will open the Measurements window. To 

begin measuring, click the ‘Distance’ button  and select the units from the adjacent drop-down list. 

Clicking consecutively on the map will add a series of green markers  to the map, between which distances 

are measured. To place the final green marker, double click on the map. The total distance will then display in 

the measurements window. To clear the previous green markers, click the ‘Clear’ button . To reset the 

measuring tool, toggle the ‘Distance’ button  on and off. 

 

SELECTING, VIEWING AND EXTRACTING COLLISION DATA 

When a collision in the CrashMap layer is clicked on a pop-

up window appears. The pop-up window can also be 

maximised using the ‘Maximise’ button , returned to 

normal size using the ‘Restore’ , and closed using the 

‘Close’ button . The ‘Zoom to’ button  changes the 

zoom of the map to focus on the crash. Clicking the  

button gives three additional options: ‘Pan to’  will change 

the extent of the map to centre around the crash; ‘Add a 

marker’ will add a blue marker to the map at the chose 

crash, which will remain visible when printed; ‘View in 

Attribute Table’  will show the 

crash as a single record in the 

attribute table. Clicking on a blue 

marker will show its co-ordinates in a dropdown 

box and clicking on the   button will give the 

option to pan to the marker or remove the 

marker. 

This window lists all the data available for the selected collision, including the severity, the number of vehicles 

and the number of casualties. At the bottom of this list of data, next to ‘Web_Link’, is a link to CrashMap to 

download the full report on this collision. 
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 Below the data are links to related tables. Clicking one of these will take you to 

the data on either the vehicles or casualties related to the collision. Clicking the 

back button  in the top right corner of the popup window will bring back the 

collision data. 

To view data on multiple items in the CrashMap layer, clicking the ‘Open Attribute Table’ button  at 

the bottom of the map opens the available attribute tables. These collect together all the available data for the 

crashes within the extent. To view all crashes in the attribute table, regardless of extent, deselect the ‘Filter by 

map extent’ button . 

 

Records in the attribute table can be selected by clicking on them. Selected 

records are highlighted blue. To select multiple records, hold down 

Ctrl/Command on the keyboard. Records can also be selected using the 

map, as explained later in this section. The ‘Clear selection’ button 

 will clear the selected records. The ‘Zoom to’ button 

 changed the extent of the map to include all of the selected 

records. The ‘Options’ dropdown 

menu   reveals an additional five buttons: ‘Show selected 

records’ reduces the attribute table to just the selected records; ‘Show 

related records’ opens attribute tables showing the ‘Casualties’ and 

‘Vehicles’ related to the selected records; ‘Filter’ allows the user to filter 

records in a way similar to building a custom filter as described later in 

the Filters section; ‘Show/Hide columns’ opens a list of field names, 

which can be selected or deselected; ‘Export selected to CSV’ exports the 

selected records to a CSV file. These options are also available in the 

‘Casualties’ and ‘Vehicles’ tables, which can alternatively be opened 

using the ‘View in Attribute Table’ option for the layer in the ‘Layer List’ 

window. To collapse the attribute tables, click the ‘Hide Attribute Table’ 

button . 

 Crashes in the CrashMap layer can also be selected using the map. 

The ‘Select Crashes’ widget in the top left corner of the map 

opens a pop-up window. The ‘Select’ dropdown gives the user 

the option to draw a point, rectangle, polygon, circle or lasso and then 

selects all crashes contained within the drawn shape. The selected 

crashes are then selected and highlighted in the attribute table at the 

bottom of the map. The ‘Clear’ button clears the selection. 

The ‘Radius Search’ widget allows the user to list all crashes 

that have occurred within a chosen radius of a point. With the 

widget pop-up open, clicking the map or using the searchbar will select 

the centre point, and the radius is set using the sliding bar. Selecting a 

crash from the resulting list will give further information, including the 
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approximate distance to the centre point as well as information about the crash, the related vehicles and the 

related casualties. 

 

The ‘Select and Report’ widget allows the user to highlight a 

region of the map and produce a report on the collisions in 

the region. The ‘Placename’ tab of the pop-up window highlights the 

area around a location, found using the search bar, within a chosen 

radius. The ‘Draw’ tab allows the user to draw a Point , Polyline 

, rectangular Extent , Polygon  or selection of crashes , and 

highlights the region within a chosen radius. Clicking the ‘Report’ 

button  produces a report on the highlighted crashes. This 

shows the area of the highlighted region, and the ‘Zoom to location’ 

button  can be used to change the extent of the map to cover the 

region. The list of crashes can be expanded using the  button, and 

the ‘Choose attributes to display’ button  to the right allows the 

user to select/deselect which fields appear in the report. 

 



 

11 
 

CRASHMAP PRO USER GUIDE – V1.23 

 

The measurement units of the report can be 

changed using the ‘Choose units for analysis’ 

button , and the report can be downloaded 

as a CSV using the ‘Download’ button  or 

printed using the ‘Print’ button . Selecting 

print will open the report in a new browser tab, 

and includes comments box to allow the user to 

add text to the report before printing. 


